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1 General Information 

1.1 Document Revision 

Date Description 

2011-05-23 Initial version of Omnicast Best Practices 

 

1.2 Contacting Technical Assistance 

Customers can reach the Genetec Technical Assistance Center (GTAC) using any one of the following 

methods: 

» Via the Genetec Technical Assistance Portal (GTAP) website: 
https://gtap.genetec.com 

» Via telephone:  
Phone:   1-514-856-7100 

Toll Free:  1-866-338-2988 (Canada and US only)  

Toll Free:   +800 01818200 (Europe*) 

 

From Monday to Friday, 8:00 AM to 8:00 PM (Eastern time, GMT -5h) 

Customers should be ready to provide all relevant information describing the problem/question, 

including System ID and version information. 

*Please visit https://gtap.genetec.com for a list of covered regions. 

 

1.3 Additional Help 

An additional knowledge resource available to customers is the GTAP Forum.  This platform allows 

for the exchange of ideas and questions between GTAP members (Genetec clients and staff) in order 

to help users make better use of their systems.  Please note this is not an extension of the GTAC, but 

simply a knowledge tool to enrich a user’s experience.  For proper support regarding a technical issue, 

please contact the GTAC as indicated in section 1.2 above. 

 

 

 

  

https://gtap.genetec.com/
https://gtap.genetec.com/
https://gtap.genetec.com/Forum/
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2 Optimizing Windows 

2.1 Introduction 

 

Optimize Your System for Peak Performance 

 

There are a lot of ways to help speed up Windows and make your PC work better with Omnicast.  

The following tips can help improve your Omnicast server or workstation’s performance. These 

examples are for any Windows operating system that is supported by Omnicast.  
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2.2 Antivirus Configuration 

 

The following configurations are required when an antivirus is installed on the same machine as an 

Omnicast server. 

If the Omnicast servers and workstations require you to have an antivirus application installed, it is necessary 

to configure exclusions. Also be sure to disable features such as “Automated Scans” & “Scan upon Definition 

Update”, as well as any network monitoring or firewall services bundled with the antivirus software. 

 
 

 
 

 It is necessary to configure exclusions on your antivirus for the following 
locations: 

1 D:\VideoArchives (or wherever your video archives are being stored) 

 

2 C:\Program Files\Microsoft SQL Server\MSSQL$OMNICAST (or wherever your 

SQL databases and logs are being stored) 

 

3 C:\ArchiverLogs, C:\DirectoryLogs and C:\GatewayLogs (or wherever your 

Omnicast logs are being saved) 

 

4 C:\Program Files\Genetec Omnicast 4.X (or the location where the Omnicast 

Server software is installed) 

5 C:\Program Files\Genetec Omnicast Client 4.X (or the location where the Omnicast 

Client software is installed) 

6 C:\Program Files\Common Files\DVR Software 4.X (may vary depending on the 

operating system language) 

 

 

 

 

 

 

GTAP Knowledgebase Article 

# KBA00191 
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2.3 Disabling Visual Effects 

Windows has a rich user interface with menus that slide into view, shadows that create three-dimensional 
effects, and rounded corners that soften the appearance of Windows. These visual effects may noticeably 

slow down its performance. To help improve the performance of your computer running Omnicast, you can 

disable visual effects. When you do so, you change only the graphical elements on your desktop; you can still 

do everything you've always done with your computer—only faster. 

How to Disable All Visual Effects                                                                                                              1 of 3 

Step Process                     

1 Right-click My Computer and click Properties. 

2 The System Properties dialog box appears. Click the Advanced tab. In the 
Performance area, click Settings. 
 

 

 

3 The Performance 
Options dialog 
box appears. On 
the Visual Effects 
tab, select Adjust 
for best 
performance 

option. 

4 Click OK on the Performance Options dialog, then OK once more on the System 
Properties dialog box to save and apply settings. 
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How to Disable All Visual Effects                                                                                                             2 of 3 

Step Process                     

1 Right-click an empty space on the desktop, and then click Properties. 

2 On the Appearance tab, click Effects. 

3 The Effects dialog box appears. Uncheck all settings. 

 

 

4 Click OK on the Effects dialog box, then OK once more on the Properties dialog box 
to save and apply settings. 

 

Use the Windows Classic Theme                                                                                                            3 of 3 

Step Process                     

1 Right-click an empty space on the desktop, and then click Properties. 

2 On the Themes tab, click Windows Classic in the Theme box. 

3 Click OK. 
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2.4 Windows Firewall 

A firewall is software or hardware that checks information that comes from the Internet or from a network 
and, depending on your settings, will either block the information or let it through. A firewall can help 

prevent malicious software (such as worms) from gaining access to your computer.  

If the Omnicast servers and workstations require you to have Windows Firewall enabled, there are certain 

procedures to follow which are described below.  

              Enabling Windows Firewall and Setting Exceptions for Windows XP and Windows Server 2003 

Step Process                     

1 Click Start, click Control Panel, and then double-click Windows Firewall. 

 

2 In the Windows Firewall window, verify that Windows Firewall is ON and “Don’t allow 
exceptions” is unchecked. 

 

 

3 In the Windows Firewall window, select the Exceptions tab. 

4 Click the “Add Program..” button. 

5 If you are on an Omnicast server, click Browse and navigate to:  

 

32-bit Windows: C:\Program Files\Genetec Omnicast Server 4.x  

64-bit Windows: C:\Program Files (x86)\Genetec Omnicast Server 4.x 
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6 Add all the Omnicast services one by one (depending which service(s) is/are installed). 
Press OK. 

 

 

 

OmniArc.exe 

OmniDFC.exe 

OmniDir.exe 

OmniFed.exe 

OmniGateway.exe 

OmniME.exe 

OmniVM.exe 

 

 

 

7 If you are on an Omnicast client station, click Browse and navigate to:  

 

32-bit Windows: C:\Program Files\Genetec Omnicast Client 4.x  

64-bit Windows: C:\Program Files (x86)\Genetec Omnicast Client 4.x 
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8 Add all the Omnicast Client applications one by one (depending which service is 
installed). Press OK. 

 

 

 

ConfigTool.exe 

LiveViewer.exe 

ArchivePlayer.exe 

 

 

 

               Setting Exceptions for Windows Server 2008, 2008 R2, Vista and 7 

Step Process                     

1 Click Start, click Control Panel, and then double-click Windows Firewall. 

  

2 Click “Allow a program or feature through Windows Firewall”.  

3 Click “Change settings”. 
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4 Click “Allow another program…”. 

 

 

 

5 If you are on an Omnicast server, click Browse and navigate to:  

 

32-bit Windows: C:\Program Files\Genetec Omnicast Server 4.x  

64-bit Windows: C:\Program Files (x86)\Genetec Omnicast Server 4.x 

 

 

  

 

 

 

6 

 

 

 

 

 

 

 

 

 

 

 

Select an Omnicast application. Press Open. 
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7 In the Add a Program window, confirm your selection and press Add. 

 

 

 

 

 

 

 

 

 

 

 

 

Repeat steps 5 to 7 for all Omnicast applications listed below (depending which 
service(s) is/are installed) 

 

OmniArc.exe 

OmniDFC.exe 

OmniDir.exe 

OmniFed.exe 

OmniGateway.exe 

OmniME.exe 

OmniVM.exe 

ServerAdmin.exe 

8 If you are on an Omnicast client station, click Browse and navigate to:  

 

32-bit Windows: C:\Program Files\Genetec Omnicast Client 4.x  

64-bit Windows: C:\Program Files (x86)\Genetec Omnicast Client 4.x 
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9 Select an Omnicast application. Press Open. 

  

10 In the Add a Program window, confirm your selection and press Add. 

 

Repeat steps 8 to 10 for all Omnicast  

applications listed below (depending which service(s) is/are installed) 

 

ConfigTool.exe 

LiveViewer.exe 

ArchivePlayer.exe 
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11 Confirm your selections and press OK. 

 

Note: Enable exceptions on all network types (E.g. Home/Work(Private), Public & Domain) 
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2.5 Windows Updates 

Microsoft makes it very easy for you to install upgrades on your PC. Normally, Windows has the updates set 
on automatic, so it will immediately download and install them, pushing changes to your PC, especially in its 

major components. You can also have the opportunity to schedule the updates. 

If your Omnicast server or workstation is connected to the Internet, these updates will automatically 
download and install. This will initiate a restart of your Windows system without proper planning. In this 

case, it is recommend to use the “Notify me but don’t automatically download or install them” feature. It is 

also recommended to have a maintenance plan in place that covers updating your machine periodically.  

If your Omnicast server or workstation is not connected to the Internet, it is recommended to have updates 

pushed through the local network. It is also recommended to have a maintenance plan in place that covers 

updating your machine periodically. 

Omnicast Server/Workstation Connected to Internet 

Step Process                     

1 Right click My Computer and click Properties. 

2 In the System Properties windows, click the Automatic Updates tab, click Notify 
me but don’t automatically download or install them.  

 

 

 

 

 

 

  

3  Click OK. 
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2.6 Uninstalling Unwanted Programs 

 

Many PC manufacturers pack their computers with programs you might not want. Keeping the software on 

your computer might slow it down by using precious memory, disk space, and processing power. 

It’s a good idea to uninstall all the programs you don’t plan on using. This should include both manufacturer-

installed software and software you installed yourself but don’t want any more, especially utility programs 

designed to help manage and tune your computer’s hardware and software. Utility programs such as virus 

scanners, disk cleaners, and backup tools often run automatically at start-up, quietly taking up precious 

resources in the background where you can’t see them. Often you have no idea they are even running. 

Even if your PC is older, it might contain manufacturer-installed programs that you never noticed or have 

since forgotten about. It’s never too late to remove these and get rid of the clutter and wasted system 

resources. Uninstalling these applications/utilities will increase the proficiency of your system while running 

Omnicast applications.  

 

Step Process                     

1 Click Start, click Control Panel, and then double-click Add or Remove Programs. 

 

 

 

2 In the Currently installed programs box, click the program that you want to remove, 
and then click Remove. 

3 If you are prompted to confirm the removal of the program, click Yes. 
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2.7 Disabling the Screen Saver 

Turning off the screen saver is recommended on client workstations to improve performance and CPU usage.  

The default screen saver should be kept on Omnicast servers. 

Step Process                     

1 Click Start, click Control Panel, and then double-click Display. 

2 In the Display Properties box, click the Screen Saver Tab. 

3 Under the Screen Saver drop down menu select (None).  Apply the settings and 
close the window. 

 

2.8 Disabling Power Management 

The “Always On” power scheme should be set on severs/workstations used for video walls.  

Step Process                     

1 Click Start, click Control Panel, and then double-click Power Options. 

2 In the Power Options Properties box, select Always On as the power scheme. 

3 Under the Settings for 
Always On power scheme, 
select Never for all entities, 
apply the settings and close 
the window. 
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2.9 Display Resolution 

Using the monitor’s native resolution is recommended. This can be achieved by selecting the highest 

available resolution in your computer display settings. 

 

Step Process                     

1 Click Start, click Control Panel, and then double-click Display. 

2 In the Display Properties box, click the Settings Tab. 

3 Under Screen resolution select the highest resolution available. Under the Color 
quality dropdown box, select the highest available. Apply the settings and close the 

window.  
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2.10 Enabling Cleartype (LCD/LED Monitors Only) 

  

Step Process                     

1 Click Start, click Control Panel, and then double-click Display. 

2 In the Display Properties box, click the Appearance Tab. 

3 Under the Appearance tab, 
select the Effects...  button. 

 

 

4 In the Effects dialogue box, select Clear Type under the “Use the following method 
to smooth edges of screen fonts:” Press OK, apply the settings and close the 

window.  

 



 genetec.com | Omnicast Best Practices 

 

22 

2.11 Disabling Unused Start-up Applications 

  

Step Process                     

1 Click Start, click Run… 

2 In the Run dialogue, type msconfig and press OK. 

3 Under the System Configuration Utility dialogue box, select the Startup tab. 

 

4 Beneath the Startup Item column, uncheck any unwanted startup applications.  

Apply the settings and close the window. Restart your computer. 
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3 Optimizing Omnicast 

 

3.1 Introduction 

 

In every video management system ensuring all configurations are set to their optimal settings is a 

vital step. 

The following tips can help optimize your Omnicast system. These examples are for any Windows 

operating system, whether it be a workstation or server.  
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3.2 Recommendations 

 

3.2.1 Windows :  

 A 64-bit operating system is recommended to run all Omnicast applications and services. Though Omnicast 

is a 32-bit application, a 64-bit architecture manages more memory. This will be more suitable to run 

Omnicast and the next Genetec Security Center platform. 

 Omnicast must not be installed on a domain controller. 

 If client applications (Live Viewer, etc.) are used for testing purposes on the servers, they must be exited 

upon finishing to save resources. 

 

3.2.2 Disk Imaging: 

 Disk imaging is not supported. 

 

3.2.3 Network: 

 Static IP addresses are recommended for Omnicast servers and video units. Avoid using DHCP. 

 If network VLANs are being used, all VLANs must be managed by the network equipment, not the servers 

or clients. VLAN tagging in Windows is not supported. 

 Windows may be used as an IGMP querier on a 3rd party server not running Omnicast. IGMP querying 

must be done on the network level if otherwise. 

 

3.2.4 Archiving: 

 Partition, LUN, and disk sizes should be 4-8 terabytes maximum in size 

 

3.2.5 Omnicast Servers: 

 No other hosting applications should be running in parallel with Omnicast. (Example: Web Servers, FTP 

Servers, Domain) 
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3.2.6 Logs: 

 Rename prefix log names for Omnicast servers; this is especially recommended in a large scale Omnicast 

system. 

                              Example of naming conventions: 

er 

Server Prefix 

Directory1 _DIR_SERVER1_ 

Gateway1 _GTW_SERVER1_ 

Gateway4 _ GTW_SERVER4_ 

Archiver6 _ARC_SERVER6_ 

Archiver13 _ARC_SERVER13_ 

 

 

Prefix names can be set in Server Admin > System > Omnicast Service > Logging 

 

 

 

 

 

 

 

 

 

3.2.7 Update Drivers 

Update all hardware drivers to the latest version supported by the manufacturer on all Omnicast servers and 

workstations.  These drivers should be downloaded from the manufacturer’s website (e.g. HP, Dell etc.)  opposed to 

the hardware component’s website (e.g. NVIDIA, Intel etc.) 

The most important drivers are: 

 Video (Video cards and Direct X) 

 Network (NICs) 

 Chipset 
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3.3 Omnicast Logs 

 

Omnicast logs should be kept as long as the video retention period. In case of missing video files these 

logs will allow for easy troubleshooting in order to investigate the root cause. This can be configured 

in the Server Admin. 

 

Step Process                     

1 Open the Omnicast Server Admin. 

2 Select an Omnicast service , then press the Logging tab. 

 

 

3 Under “Keep log for :”  set the value to the same as your Video Retention period. 

 

4 Repeat steps 2 and 3 for each Omnicast service. 
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3.4 Alarms 

 

3.4.1 Alarm History 

Alarm history kept in the database (AlarmSQL) is recommended to be the same as the retention 

periods of the cameras. Depending on the needs of the system, the alarm history may be set otherwise.  

3.4.2 Alarm Acknowledgment 

High volume Omnicast systems with many alarm entities have the ability to turn on a feature called 

“Automatic Acknowledgment”. This feature is especially useful when there are many alarms coming 

in at the same time.  

 

3.4.1 Alarm History 

Step Process                     

1 Open the Omnicast Server Admin. 

2 Select the Directory Service, then press the General tab. Under Keep history for, 
enter the retention period. 

 

 

3 Apply the settings. 
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3.4.2 Alarm Acknowledgment 

Step Process                     

1 Open the Omnicast Config Tool and login to the Omnicast system. 

2 Navigate to Alarm Management. 

 

 

3 Select an alarm from the Alarm Management tree. Click the Properties button. 
Enable Automatic acknowledgement after. 

Set the amount of time it will take before the Alarm is acknowledged automatically. 

Example 

 

 

4 Repeat Step #3 for each alarm entity. Apply the Settings 
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3.5 Deleting Unused Archiver Extensions 

 

To save on precious Archiver resources, deleting unused Archiver extensions is recommended. 

 

Step Process                     

1 Open the Omnicast Server Admin, stop the Archiver service. 

2 Under the Archiver tree, right-click and Delete any unused extensions. 

 

 

3 Start the Archiver service. 
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3.6 Configuring Scheduled Backups 

 

Setting up scheduled backups is an important step in any Omnicast environment. These backups hold 

key system information such as databases and registry information. In case of system failure you will 

always be able to return your system to a previous backed up state. 

Omnicast Backup supports the following features: 

 

 Runs as a command line function  

 Backs up the Omnicast databases (DirectorySQL, AlarmSQL, VideoArchiveSQL, ReportingSQL, 

AuxiliaryArchiveSQL, ObjectStore, etc.)  

 Backs up the registry (includes the software license)  

 Keeps the results of a single backup operation in a single .zip file  

 Maintains the most recent backup files on disk  

 Produces a detailed trace of all operations with optional timestamps  

 
Step #1 – Creating the Omnicast Backup Batch File 

Step Process                     

1 Right-click on your desktop, navigate to New and select Text Document. 

 

 

 

 

2 Once the text document is created rename the file to: OmnicastBackup 
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3 Open the newly created OmnicastBackup text document.  

 

Enter the following line : omnibackup -b X:\BackupFolder –MAX_BACKUPS 20  (X= 
Drive with sufficient space to hold backups, avoid using the C drive) 

 

Note: -MAX_BACKUPS 20 string will keep backup files for a maximum of 20 days. 

 

Example: 

 

 

 

 

 

4 Select File and Save, then close the text document.   

5 Create a folder named: Omnicast Scheduled Backup  on C:\. Cut and Paste 
OmnicastBackup.txt to C:\Omnicast Scheduled Backup 

6 Click Start, click Run, type cmd, and then click OK. 

7 Using the Command Prompt window navigate to C:\Omnicast Scheduled Backup   

 

Enter the following command line and press Enter : 

 

rename OmnicastBackup.txt OmnicastBackup.bat 

 

 

Upon completion you will have a MS-DOS Batch File located in C:\Omnicast 
Scheduled Backup 
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Step #2 – Copy OmniBackup.exe  

Step Process                     

1 Navigate to OmniBackup.exe, located in one of the following locations: 

a) C:\Program Files\Genetec Omnicast Server 4.X 

                                            or 

b) Omnicast Installation Material (located in “Tools/Free Omnicast          

Tools/Backup Tool” Folder) 

 

 

 

2 Copy OmniBackup.exe and Paste in Omnicast Scheduled Backup folder (created 

in step #1-5) 

Upon completion you will have two files in the Omnicast Scheduled Backup folder. 

 

 

 

 

 

 

 

 

 

 

 

 

 



 genetec.com | Omnicast Best Practices 

 

33 

 

 

Step #3a – Creating a Scheduled Backup in Windows XP/Server 2003 

Step Process                     

1 Click Start, click Control Panel, and then double-click Scheduled Tasks. 

 

 

 

2 In the Scheduled Tasks window, double-click Add Scheduled Task. 

 

 

 

 

3 In the Scheduled Task Wizard dialog box, click Next. 
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4 Click on Browse, then navigate to the C:\Omnicast Scheduled Backup folder and 
select the OmnicastBackup.bat file. Click on Open. 

 

 

 

 

 

 

 

 

5 Select how often you would like to have your Omnicast system backed up and click 
Next. 

Note: It is recommended to have daily backups 

Example: 
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6 Set entities and press Next. 

Example: 

Daily Backup set 12:00 AM 

 

 

 

 

7 Set your Windows Login Information and press Next. 
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8 Confirm details and press Finish. 

 

 

 

 

Step #3b – Creating a Scheduled Backup in Windows Server 2008, 2008 R2, Vista and 7 

Step Process                     

1 Click Start, type taskschd.msc in the Search programs and files field and press 
Enter. 

 

 

 

2 In the Task Scheduler window, click Create Basic Task… 
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3 In the Create Basic Task Wizard window, enter a name for the task, click Next. 

 

 

4 Select how often you would like to have your Omnicast system backed up and click 
Next. 

Note: It is recommended to have daily backups. 

Example: 
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5 Set entities and press Next. 

Example:  

 

 

 

 

 

 

  

6 Select Start a program and press Next. 
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7 Click on Browse, then navigate to the C:\Omnicast Scheduled Backup folder and 
select the OmnicastBackup.bat file. Click on Open. 

 

 

 

8 

 

 

 

 

 

Confirm the Program/script selection and press Next. 
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9 Confirm details and press Finish. 
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3.7 Failover/Reverse Gateway Network Settings 

 

If the Omnicast system utilizes Directory failover and the Failover Directory is located outside of the 

main Directory’s LAN, the Public Address field in the Server Admin should be populated. This is 

used so the main server can be accessed from outside its current LAN. This configuration is 

mandatory for any system running a DFC (Directory Failover Coordinator) or multiple Gateways.  

 

 

Step Process                     

1 Open the Omnicast Server Admin.  

2 Under System, select the Network tab. Under Public address, enter the IP of the 
main server. 

 

 

 

3 Apply the settings. 
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3.8 Setting Empty Layout for Administrators 

 

Setting an empty layout in Live Viewer for administrators will help you connect faster and avoid 

system lock ups when troubleshooting, especially when Omnicast clients are open on the server. 

 

Step #1 – Creating an Empty Layout Site 

Step Process                     

1 Launch Omnicast Config Tool and log on as an administrator. 

 

 

2 Click Action > Create > Logical View > Site 

 

3 Name the newly created site Empty Layout. 
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Step #2 – Creating an Empty Layout in Live Viewer 

Step Process                     

1 Launch Omnicast Live Viewer and log on as an administrator. 

 

 

2 Using the Change pattern button, select the 1 pane layout. 

 

3 Click on the pencil to enter edit mode and select Save  

 

4 In the Save viewer layout box, select the Empty Layout site and click Save. 
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5 Exit Live Viewer. Select Yes when asked to save changes. 

 

 

 

. 
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3.9 Automatic Start-up of Omnicast Applications 

 

Depending on your Omnicast environment, you may want to set your workstation to automatically start an 

Omnicast application when starting Windows. This can be done using one of the methods below. 

 

Method #1: Windows will automatically start an Omnicast application and the user will be prompted to 

login.  

Method #2: Windows will automatically start an Omnicast application and log in using predefined user 

credentials without user intervention. 

 

Method #1 

Step Process                     

1 Navigate to:  

C:\Program Files\Genetec Omnicast Client 4.X 

 

 

 

 

 

Right-click and Copy an Omnicast application of your choice. 

 

 

 

 

 

 

 

 

GTAP Knowledgebase Article 
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2 Navigate to the Windows Startup folder: 

C:\Documents and Settings\<LOCAL USER>\Start Menu\Programs\Startup 

Right-click and Paste the Omnicast application from the above step. 

 

 

 

 

 

 

Restart the workstation. The Omnicast application(s) will now start automatically. 

 

Method #2 

Step Process                     

1 Navigate to:  

C:\Program Files\Genetec Omnicast Client 4.X 

 

 

 

 

 

Right-click and Copy an Omnicast application of your choice. 
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2 Navigate to the Windows Startup folder: 

C:\Documents and Settings\<LOCAL USER>\Start Menu\Programs\Startup 

Right-click and Paste the Omnicast application from the above step. 

 

 

 

 

 

3 Navigate to the Windows Startup Folder: 

C:\Documents and Settings\<LOCAL USER>\Start Menu\Programs\Startup 

Right-click the Omnicast application of your choice and select Properties. 

 

4 In the Target field, edit the target as follows: 
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 Example 

 

If you wish to launch the Live Viewer application and have it automatically connect to 
the Directory named video-server with the username Roger and password 123456, the 

resulting target line would be:  

 

“C:\Program Files(x86)\Genetec Omnicast Client 4.X\LiveViewer.exe” /d video-server /u 
Roger /w 123456 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: 

application.exe” [/d gateway-name] [/u user-name] [/w password] 

 

 

 

 

  

/d Specify the gateway name 

/u Specify the user name 

/w Specify the password 

4 Click OK, restart the workstation. The Omnicast application will now start and log in 
automatically. 
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3.10 Windows NTP Synchronization 

 

The Windows Time service (W32Time) is designed to maintain date and time synchronization for computers 

running Windows. W32Time is based on the Simple Network Time Protocol (SNTP) designed to ensure 

loose synchronization only, which means the clocks of all Windows machines in a forest will agree within 20 

seconds of one another (or 2 seconds difference within a particular site).  

 

If there is a domain controller on the network, every computer on that domain will automatically be 

synchronized with that computer. Otherwise, manual configurations need to be made. Once configured, the 

Time Server will synchronize the client clock periodically. It is recommended to use a dedicated network 

clock source instead of using the PC as a time server. 

On the PC Used as the Time Server: 

Step Process                     

1 Windows XP, Server 2003  

Click Start, click Run, type cmd, and then click OK. 

Windows Server 2008, 2008 R2, Vista and 7 

Click Start, click Run, type cmd, right-click cmd and select Run as administrator 

 

2 Using the Command Prompt window, stop your time service by typing the following 
command followed by Enter: 

net stop w32time 

 

 

 

 

Close the Command Prompt window. 

3 Click Start, click Run, type regedit, and then click OK. 

GTAP Knowledgebase Article 
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4 Using the Registry Editor window navigate to the following registry keys: 

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\W32Time\Paramet
ers 

5 Create the following two registry keys: 

NameLocalNTP (DWORD value), value=1 

ReliableTimeSource (DWORD value), value=1 

To create a registry key select Edit > New > DWORD Value 

 

 

 

 

 

 

 

 

Rename the key to an appropriate value. 

 

 

 

 

 

Right-click the key and select Modify. 
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Set it to the correct value and press OK. 

 

 

6 Close the Registry Editor window. 

7 Click Start, click Run, type cmd, and then click OK. 

8 Using the Command Prompt window, start your time service by typing the following 
command followed by Enter: 

 net start w32time 

 

 

 

 

Close the Command Prompt window. 
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On the PCs Used as SNTP Clients: 

Step Process                     

1  Click Start, click Run, type cmd, and then click OK. 

2 Using the Command Prompt window stop your time service by typing the following 
command then press Enter: 

net stop w32time 

 

 

 

 

           

 

 

 

3 In the same Command Prompt window enter the following command, then press 
Enter: 

W32tm /config /manualpeerlist:<ntpserver> /syncfromflags:MANUAL 

Note: <ntpserver> = Time Sever Name or IP 

 

4 In the same Command Prompt window, enter the following commands then press 
Enter: 

Net start w32time 
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W32tm /config /update 

 

 

 

W32tm /resync (forces the 1
st
 synchronization to the time server) 

 

 

 

Close the Command Prompt window. 

 

By default, the time synchronization will occur once every 45 minutes until 3 good synchronizations occur, 

then once every 8 hours (3 per day in total). 
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3.11 Enabling “Telnet” and “Power Shell” Features in Windows 2008 

 

Telnet Client allows a computer to connect to a remote Telnet server and run applications on it. This feature is 

used for troubleshooting various Omnicast components. 

PowerShell is a command-line shell and scripting language that helps administrators achieve greater 

productivity and control system administration more easily.  

 

Step Process                     

1  Click Start, and select Server Manager. 

2 From the left panel in Server Manager, click on Features. 

 

 

 

 

3 Click on Add Features. 

 

 

4 From the available list of features, scroll down and select Telnet Client and Windows 
PowerShell, then click Next. 
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5 On the Confirmation page, click on Install. 

 

 

 

6 Once installation is completed, click on Close. 
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4 Securing Omnicast 

4.1 Introduction 

 

Security is always a high priority when it comes to video management systems. The following tips 

will help secure your Omnicast system.  
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4.2 Recommendations 

 

4.2.1 System Units :  

 Change the default username and password of any video units or encoders attached to your system.   

Note: If credentials are changed on video units used on an existing Omnicast System, they will need to be re-

added to Omnicast for proper functionality.  

Set these changed credentials in Server Admin > System > Archiver > Archiver Extension > General > 

Default login 

            Example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.2.2 Omnicast Specific : 

 Always set a password for the Admin user. 

 In the case of a Federated Omnicast system, create a new user with limited rights and a password. This user 
should only be used to access the Federation service. 

4.2.3 Windows Specific : 

 Windows updates should be installed periodically. This will always insure a secure Omnicast environment. 
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4.3 Securing Omnicast Services  

 

By default, the Omnicast installation will create a new user on your Windows system (OmnicastSvcUsr) to 

run all of your Omnicast services. To create a more secure environment it is recommended to change the 

password of the OmnicastSvcUsr. Another option is to select a user to run all Omnicast services during the 

initial Omnicast Server installation. 

 

              Changing the “OmnicastSvcUsr” Password 

Step Process                     

1 Click Start, click Run, type compmgmt.msc, and then click OK. 

Note: Administrator rights are required to make any changes to the OmnicastSvcUsr. 

2 In the Computer Management window, navigate to Computer Management (Local) > 
System Tools > Local Users and Groups > Users 

 

 

 

3 Right-click the OmnicastSvcUsr and select Set Password. 

 

 

 

 

 

 



 genetec.com | Omnicast Best Practices 

 

59 

4 In the Set Password for OmnicastSvcUsr window, select Proceed. 

 

 

 

 

 

5 In the Set Password for OmnicastSvcUsr window, enter a New password and press 
OK. Close all windows. 

 

 

 

6 Click Start, click Run, type services.msc, and then click OK. 

7 In the Services Window, navigate to your Genetec Omnicast services. 

Depending on your Omnicast System, you may have several Omnicast services : 

 Genetec Omnicast Directory  

 Genetec Omnicast Directory Failover Coordinator 

 Genetec Omnicast Gateway 

 Genetec Omnicast Virtual Matrix 

 Genetec Omnicast Archiver 

 Genetec Omnicast Restore Archiver 

 Genetec Omnicast Auxillary Archiver 

 Genetec Omnicast Federation Server 

 Genetec Omnicast Metadata Engine 

8 For each Genetec Omnicast service listed in your Services window, change the 
password to the newly created one. 
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9 Right-click a Genetec Omnicast service and select Properties. 

 

 

10 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the service’s Properties window, select the Log On tab. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 genetec.com | Omnicast Best Practices 

 

61 

11 In the service’s Properties window, change the Password to the newly created 

password made in Step #5. 

 

 

 

12 Upon setting a new user, click Apply. In the Services dialogue window, click OK. 

 

 

 

 

Close all windows and restart your computer for the new setting to take effect. 
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4.4 Setting Up a Password for the Omnicast Console  

 

The Omnicast Console uses the Windows Telnet feature to debug any one of the Omnicast services. This is 

used for troubleshooting and monitoring of the Omnicast system. Setting a password restricts any 

unauthorized users from telnetting into any one of the Omnicast services. 

          

Step Process                     

1  Open the Genetec Watchdog tray. 

 

2 In the Genetec Watchdog tray window, select the Options button. 

 

 

3 In the Application options window, select Console. 

 

 

4 Define a password for each Omnicast service in the Password column.   

 

 

5 Press OK and close the Omnicast Watchdog tray window. 
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5 Optimizing Omnicast’s Network 

5.1 Introduction 

 

The optimization of your Omnicast Network will lead to enhanced performance and security, this is often 

overlooked. In this section you will learn how to optimize and harden your network connections efficiently 

and effectively. 
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5.2 Recommendations 

 

5.2.1 Network Devices: 

 Enable Internet Group Management Protocol (IGMP) snooping on Layer 2 devices. 

 Enable Internet Group Management Protocol (IGMP) querier on Layer 3 deceives. 

 Enough IGMP groups must be allocated for the system.  These groups are used for the following : 

I. Camera streams 

II. Sequences 

III. Analog monitors 

IV. Video walls 

V. Multicast test address 

 Link Aggregate Groups (LAGs) not recommended. 

 In the case NIC teaming is used, ensure all network equipment supports it. Also, it is recommended to 

configure the teaming in failover mode. If other modes are required, like load balancing, ensure that the 

switch is configured properly to support the teaming mode. 

 Upgrade to the latest supported firmware for all network devices (e.g. switches, routers etc.) 
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5.3 Network Adapter Binding Order 

 

When you install Windows, the order of the connections may vary depending on how the network adapters 

are enumerated. You can use the method below to reorder adapters and bindings, and to change the interface 

metric on the network adapters.  

You may have several network connections that are connected to different networks. In this case Omnicast 

will need to use the first connection in the network connections list. You may want to make sure that the 

Omnicast network connection is at the top of the list. It is also recommended to disable any unused NICs 

and rename any current NICs (example: Omnicast Network Main) 
 

 

Step Process 

1 Navigate to Control Panel > Network Connections 

 

 

2 Open Advanced > Advanced Settings… 

 

 

 

 

3 In the Connections area, select the 
network adapter that is associated 
with Omnicast and move it up to the 
first position. 

Use the arrow buttons to move the 
connection. 
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5.4 Setting Up the Interface Metric 

 
Changing the interface metric will make one network adapter more favorable for all TCP/IP connections. This 

will optimize all Omnicast services. This should be done on the Omnicast NIC only. 

Note: Please follow Section 5.3 of this guide prior to setting up interface metric. 

 

Step Process                     

1  Click Start, click Run, type ncpa.cpl, and then click OK. 

2 The available connections will appear in the Network Connections window. 

3 Right-click the network adapter used for your Omnicast network, and click Properties . 

 

 

 

4 Click the General tab and under the “This connection uses the following items:” 
box, select Internet Protocol (TCP/IP). Then, click Properties. 
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5 In the Internet Protocol (TCP/IP) Properties dialog box, click the General tab, and 
then click Advanced. 

6 On the IP Settings tab, click to clear the Automatic metric check box. Then, type the 
value of 1 

 

 

 

 

7 Click OK three times to close all windows. 
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5.5 Multicast Connection Test Settings 

 

In order to test the multicast connectivity with a client, the Gateway specifies two IP addresses: one for the 

client to receive multicast transmissions from the Gateway, another for the Gateway to receive transmissions 

from the client. 

The Gateway uses a pool of addresses for client transmissions, which it assigns in turn to connecting clients. 

Using multiple client transmission addresses helps avoid network congestions, especially when the Gateway 

restarts.  

If your Omnicast system utilizes more than one Gateway, it is recommended to change the multicast 

connection test IPs in the Server Admin for each Omnicast Gateway server in the system. 

 

Changing the Multicast Connection Test Setting         

Step Process                     

1  Run Server Admin on the server running the Gateway service. 

 

2 Navigate to System > Gateway > General > Multicast connection test settings 

Example:      

  Gateway #1 

 

 

 

                        
Gateway #2 
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5.6 Multicast Registry Settings 

 

If multicast streaming is enabled in the Omnicast system but multicast is not properly enabled on the server, 

you may experience the following: 

 The unit-Archiver setting on the camera is set to Unicast UDP and the stream is being recorded in the Archiver, 

yet you see “waiting for signal” when trying to view the live stream directly on the Gateway server. 

 All Omnicast services do not detect multicast supported on the Gateway, even when they are on the same server 

as the Gateway. 

 When you try to join a multicast group using a 3rd party multicast tester, it fails and there are no IGMP packets 

leaving the server (shown in a packet trace). 

Ensuring that your Windows registry is set to the correct IGMP versions will help you avoid the above 

mentioned network issues. 

 

Step Process                     

1 Click Start, click Run, type regedit, and then click OK. 

2 Using the Registry Editor window, navigate and edit the following registry keys: 

 

I. HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parame
ters\ 

IGMP Level = 2 

II. HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parame
ters\ 

IGMPVersion  = 3 (for layer 2) or 4 (for layer 3)  

 

 

 

 

 

 

 

GTAP Knowledgebase Article 
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6 Optimizing Omnicast’s Storage 

6.1 Introduction 

 

An integral part of Omnicast is its Archiver service. Optimizing this part of Omnicast will allow for a clean 

and efficient archiving environment.   
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6.2 Recommendations 

 

6.2.1 Storage : 

 New Technology File System (NTFS) is the preferred file system for archiving. 

 The preferred New Technology File System (NTFS) cluster size is “Largest Available”. 

 Storage-level disk compression is not recommended. 

 Do not create multiple partitions on the same disk (logical drives) and use them for archiving.  

           Example 

 Disk A = 2 Terabytes             Full disk size used as 1 partition Drive D: (2TB) 

 Disk B = 2 Terabytes             Full disk size split into multiple partitions Drive F: (1TB) , Drive G: 

(1TB) 

 Do not archive on the same disk used to run Windows. Using the same disk could crash Windows due to 
Windows running out of disk space. 

 Archiving disks must be dedicated to the Archiver and must not be used by other software. 

 Do not allocate the same disk to multiple Archivers. 

 If Archiver backups are enabled, they must not be done on the same physical disk as the one recording the 

original video. 

 Storage LUN sizes are recommended to be  4-6 Terabytes each 

 

 

 

 

 

 

 

 

 

 

 

 



 genetec.com | Omnicast Best Practices 

 

72 

6.3 Disabling Storage Indexing 

It is recommended to deactivate the indexing service on the video archive drive(s).  

 

Step Process 

1 Go to My Computer.  

2 Right-click on the drive that is storing your video archives and go to Properties.  

3 In the General tab, remove the check mark next to “allow indexing service 
to index this disk for fast file searching”. 

 

 

 

 

 

 

 

 

 

 

 

 

4 Click Apply. 

5 Select Apply changes to X:\, 
subfolders and files, and press 
OK and close all windows. 

 

 

 



 genetec.com | Omnicast Best Practices 

 

73 

6.4 Setting Video File Sizes 

 

The recommendations below are applicable to Omnicast systems with larger retention periods (6 

months +) and set to continuous recording. Configuring these file sizes properly will provide more 

organized and efficient disk drives.  

If recording at a lower bit rate, it is recommended to set your output files to a larger size per file.   

 

Step Process 

1 Run Server Admin on the server running the Archiver service. 

 

 

2 Navigate to System > Archiver > Archiving > Archiving Options … 

 

 

 

 

 

 

3 In the Archiving Options window, under Video files, set the values to what is 

recommended below: 

 

 

 

 

 

 

 

 

 

Recording Frames per 

Second (FPS) 

Video Files Maximum 

Length (mins) 

2 60 

4 45 

5-7 30 

6-8 20 
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6.5 Archiver Minimum Free Space 

To ensure that the Archiver will be able to delete and create new files without any errors, a minimum 

free space should be defined in the Server Admin of the Archiver. This free space will not be used for 

video storage. Therefore, this additional video storage must be added in excess of the required video 

storage. 

                                                                  Minimum Free Space Rules       

Partition (disk) Size Minimum Free Space 

8 Terabytes 16 Gigabytes 

4 Terabytes 8 Gigabytes 

1 Terabyte 4 Gigabytes 

500 Gigabytes 2 Gigabytes 

 

Step Process 

1 Run Server Admin on the server running the Archiver service. 

 

 

2 Navigate to System > Archiver > Archiving. Set “Display minimum free space 

in:” to GB   

 

 

 

 

3 Set “Min free space” as per the Minimum Free Space Rules listed above. 

 

 

 

 

 

 

 

4 Apply settings 
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7 Omnicast and Database Preventive Maintenance 

7.1 Introduction 

Ensuring Omnicast performs optimally requires keeping a disciplined maintenance routine. This will 

insure stability of the system.  
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7.2 Omnicast Orphan/Missing Files Clean-up 

 

An orphan file is a video file that is no longer referenced by a designated archive database. These files, 

if not deleted manually, will stay on disk forever, since the Archiver can only delete files that are 

referenced by its database. 

A missing file is a video file that no longer exists on any Archiver storage capacity. Cleaning the 

database of these old entries is also recommended. 

 

Orphan File Search  

Step Process                     

1  Run Server Admin on the server running the Archiver service. 

 

2 Navigate to System > Archiver > Archiving. . Click the Find orphan files button. 

 

  

3 Select a folder and click Search. A search progress window will be displayed while the 

tool is searching for orphan files under the selected folder. All G64 files that are not 

referenced by the Archiver database will be listed in the Orphan Files list. 

4 Choose how you wish to handle the orphan files. You have the choice to delete or to 

quarantine the selected files. If you choose to quarantine the selected files, you will be 

prompted to enter a quarantine folder. 

5 Click OK when you are finished. 

 

 

 

 

javascript:WebWorksHTMLHelp.fShowPopup('popups/Glossary-1258847.txt');
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Missing File Search  

Step Process                     

1  Run Server Admin on the server running the Archiver service 

 

2 Navigate to System > Archiver > Archiving. . Hold SHIFT and click the Find orphan 
files button. 

 

  

3 Select a folder and click Search. A search progress window will be displayed while the 

tool is searching for missing files under the selected folder. All G64 files that are 

referenced by the Archiver database but not in any Archiver storage capacities will be 

listed in the Missing Files list. 

4 Choose how you wish to handle the missing files. You have the choice to delete or to 

quarantine the selected files. If you choose to quarantine the selected files, you will be 

prompted to enter a quarantine folder. 

5 Click OK when you are finished. 
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7.3 Reviewing SQL Logs 

Review the SQL Server error logs to ensure that processes have completed successfully (for example, 

backup and restore operations, batch commands, or other scripts and processes). This can be helpful to 

detect any current or potential problem areas, including automatic recovery messages (particularly if 

an instance of SQL Server has been stopped and restarted), kernel messages, or other server-level error 

messages. 

View the SQL Server error log by using SQL Server Management Studio or any text editor. By 

default, the error log is located at Program Files\Microsoft SQL 

Server\MSSQL.n\MSSQL\LOG\ERRORLOG and ERRORLOG.n files. 

 

Review Logs via SQL Management Studio 

Step Process                     

1  Run SQL Management Studio, log into your Omnicast data server database. 

2 In the Microsoft SQL Server Management Studio, expand the SQL Server. 

3 In the Object Explorer, expand Management  SQL Server Logs. 

 

 

4 Choose the error log you want to see, for example the current log file.  

The date beside the log indicates when a log was changed the last time. 

5 Double-click the log file or right-click on it and select View SQL Server Log. 

In the left-hand window, you see a list of all error logs. 

In the right-hand window, you see the content of the selected files. 
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Review Logs via Notepad 

Step Process                     

1  Navigate to: 

C:\Program Files\Microsoft SQL Server\MSSQL10_50.OMNICAST\MSSQL\Log 

2 Open the ERRORLOG file of your choice and select Notepad in the Open With  
window. Select OK. 
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7.4 Running SQL Queries 

SQL Queries will check the logical and physical integrity of all the objects in the specified database. It is 

recommended to run these steps on an offline backup of the database, not on the live database wherever 

possible. 

 

Step Process                     

1 Run SQL Management Studio, log-in to your Omnicast Data Server database. 

2 In the Microsoft SQL Server Management Studio Express, select New Query. 

 

 

3 Select a database. 

 

 

4 Upon Selecting a database , type dbcc checkdb  in the query field. 
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5 Click Execute. 

 

 

6 Review the report generated, and verify there are no errors. 

 

Repeat Steps 3-6 for each Database (Master, Model...) 
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8 Recommended 3
rd

 Party Software 

The following software is recommended for use with your Omnicast system. This will ensure 

easy troubleshooting when system issues occur, especially when calling into Technical 

Support. 

Wireshark  

Wireshark is a network protocol analyzer. It lets you capture and interactively browse the 

traffic running on a computer network. It has a rich and powerful feature set and is the 

world's most popular tool of its kind. It runs on most computing platforms including Windows, 

OS X, Linux, and UNIX.  

Network professionals, security experts, developers, and educators around the world use it 

regularly. It is freely available as open source, and is released under the GNU General Public 

License version 2. 

 

It is developed and maintained by a global team of protocol experts, and is an example of 

adisruptive technology. 

http://www.wireshark.org/ 

 

Microsoft SQL Management Studio 

Microsoft SQL Server Management Studio is a free, easy-to-use graphical management tool for 

managing SQL Server 2005 Express Edition and SQL Server 2008 R2. SSMSE can also manage 

instances of the SQL Server Database Engine created by any edition of SQL Server 2005 and SQL 

Server 2008 R2. 

SQL Server 2005 Express 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=c243a5ae-4bd1-4e3d-94b8-

5a0f62bf7796#Overview 

SQL Server 2008 Express R2 

http://www.microsoft.com/express/Database/InstallOptions.aspx  

 

Microsoft Debug Diagnostics 

The Debug Diagnostic Tool (DebugDiag) is designed to assist in troubleshooting issues such as 

hangs, slow performance, memory leaks or fragmentation, and crashes in any user-mode process. 

The tool includes additional debugging scripts focused on Internet Information Services (IIS) 

applications, web data access components, COM+ and related Microsoft technologies. 

 

http://en.wikipedia.org/wiki/Disruptive_technology
http://www.wireshark.org/
http://www.wireshark.org/
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=c243a5ae-4bd1-4e3d-94b8-5a0f62bf7796#Overview
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=c243a5ae-4bd1-4e3d-94b8-5a0f62bf7796#Overview
http://www.microsoft.com/express/Database/InstallOptions.aspx
http://www.microsoft.com/express/Database/InstallOptions.aspx
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http://www.microsoft.com/downloads/en/details.aspx?familyid=28bd5941-c458-46f1-b24d-

f60151d875a3&displaylang=en 

 

Sysinternals 

The Sysinternals Troubleshooting Utilities have been rolled up into a single suite of tools. This file 

contains the individual troubleshooting tools and help files. It does not contain non-troubleshooting 

tools like the BSOD Screen Saver or NotMyFault. 

 

http://technet.microsoft.com/en-us/sysinternals/bb842062 

 

Remote Desktop Connection Manager 

RDCMan manages multiple remote desktop connections. It is useful for managing server labs 

where you need regular access to each machine such as automated check-in systems and data 

centers. It is similar to the built-in MMC Remote Desktops snap-in, but more flexible. Very useful 

tool for large Omnicast systems. 

 

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=4603c621-6de7-4ccb-9f51-

d53dc7e48047 

 

NetTime 

NetTime is a simple time synchronization client for all versions of Windows. Its main claim to fame 

is that it is small, simple and unobtrusive. 

 

http://www.timesynctool.com 

 

  

 

 

 

 

 

 

 

 

 

http://www.microsoft.com/downloads/en/details.aspx?familyid=28bd5941-c458-46f1-b24d-
http://www.microsoft.com/downloads/en/details.aspx?familyid=28bd5941-c458-46f1-b24d-
http://technet.microsoft.com/en-us/sysinternals/bb842062
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=4603c621-6de7-4ccb-9f51-d53dc7e48047
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=4603c621-6de7-4ccb-9f51-d53dc7e48047
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9 Useful Tips 

9.1.1 Enable Remote Desktop 

Enabling Remote Desktop will allow for easy troubleshooting. Remote Desktop should be enabled on all Omnicast 

servers and client workstations. 

 

Step Process                     

1  Click Start, click Control Panel, and then click System. 

2 Click the 
Remote 
tab, click to 
select the 
Allow 
users to 
connect 
remotely to 
your 
computer 
check box, 
and then 
click OK. 
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9.1.2 Cameras, Encoders, Decoders 

 Check compatibility in Omnicast Release Notes. 

 Upgrade to the latest supported firmware listed on Genetec’s Technical Assistance Portal (GTAP): 

https://gtap.genetec.com/ 

 

9.1.3 Omnicast Applications 

Avoid accessing all Omnicast applications through Remote Desktop, VNC and Citrix Viewer 

 

9.1.4 Entities Globally Unique Identifier (GUID) 

1) In the Config Tool, select an entity  

2) Navigate to the Identity tab 

3) Place your cursor in the Description field 

4) Press CTRL + SHIFT + R 

5) The GUID will be displayed 

 

9.1.5 Special Build Description for DLLs 

1) In any Omnicast application, go to Help/About 

2) Hold the CTRL+SHIFT keys and press the File Versions button 

3) All the DLLs loaded by the application will appear, along with special build descriptions. This is 

useful to identify fixes that have been applied to the system. 

Note: only DLLs loaded 

by the application will be 

displayed. DLLs loaded by 

Omnicast services will not 

be displayed. 

 

 

 

 

 

 

https://gtap.genetec.com/
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9.1.6 Express Archiver Statistics 

When refreshing the Archiver’s statistics, the Archiver normally has to check all video files on the 

recording drives. This process can take several minutes.  

In order to refresh the statistics faster: 

1) In Omnicast Config Tool > Physical View > Archiver > Statistics 

2) Hold SHIFT and press the refresh button 

3) This will refresh all the information except for “Disk usage”  

 

9.1.7 Re-Indexing Video Files 

This functionality is built-into Omnicast versions 4.4 and later (HF294 makes it available in 4.2) 

1) In Server Admin > Archiver > Archiving start an orphan files search 

2) All the video files not referenced in the database will appear during the search 

3) To re-index the video files, hold SHIFT and press the Quarantine button 

4) You will receive a warning asking if you want to re-index the orphan files in the VideoArchive SQL 

database. Select YES 

5) All selected orphan files will be re-indexed in the database 
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Annex 

Genetec Technical Assistance Portal (GTAP) Article Links 

 

Antivirus Configurations – Page #8 

KB Article # KBA00191 

https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=191 

 

Windows NTP Synchronization – Page #36 

KB Article # KBA00022 

https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=22 

 

Automatic Start-up of Omnicast Applications – Page #46 

KB Article # KBA00162 

https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=162 

 

Multicast Registry Settings – Page #58 

KB Article # KBA00275 

https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=275 

 

 

https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=191
https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=22
https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=162
https://gtap.genetec.com/Library/KnowledgeBaseArticle.aspx?kbid=275

